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Introduction

Welcome to Unit Standard 27642 v1 Use a pivot table to display data with Microsoft Word
2013.

This book has been written using Microsoft Excel 2013 with Windows 8.1. (The Windows 7
operating system can be used. However screen shots will differ slightly from those shown in
this book.)

Retrievable Exercise Files

Some exercise files have been created for you to prevent time in keying in many exercises. You
can then open these files and use the features of Excel to manipulate and format text.

A list of these files is shown on page ix and instructions for downloading these files from our
web site are included on page x.

What you will learn
In this course you will learn how to —

Use a pivot table to display data:
e Create and edit a pivot table

e Create a pivot table report including a pivot chart

How you will learn

This book is divided into sections. /Each section page lists the learning outcomes for that
section. You will work through each section and do all exercises (or those instructed by your
tutor).

Revision theory is included at the end of each section. A Practice Assessment is included at the
end of Section 3. Our books include accumulation and consolidation of learning which carries
across each section.

After you have completed the book your tutor will give you the actual Unit Standard
Assessment.



forecast

= to
calculate a
future
result

Ctrl S

Word meaning boxes

Sometimes you will see a box at the left side of the page of a line that has dotted underlining.
This box will contain information to help you understand the meaning of the underlined word
(or how that word is formed). An example is shown below.

sales figures. Worksheets can be saved, opened and printed as required.

Different Excel buttons

Depending on the size of your Excel screen, buttons on the ribbon may vary to those shown in
this book. The icon with the word of that feature may show, or the icon only.

For example, the Copy button in the Clipboard group on the Home tab;may‘be displayed in
either of the following ways.

Em Copy OR R
The Symbol button can show as either -

Q

Symbaol

-

€2 Symbol - OR

Shortcut keys

Shortcut keys are indicated in the left margif, usually the first time they are used. An example
follows.

1 Click on the Save button H on thesQuick Access Toolbar H <~ O = |

2 Type a file name for your documentithen click on Save.

Glossary

Generally when a word(s) is fifstiused that is a technical term or a word that you may not know
that relates to an exercise, orja, particular Excel 2013 feature, a description is given. You will
also see that such words are’in, SMALL CAPs.

These terms are listed on.each section page, an example is shown below. Explanations are also
included in the Glossary at'the end of the book.

% In this section you will come across the following words highlighted in bold. This
indicates that the word is included in the Glossary at the end of the book together
with a description of that word.

AUTOCORRECT FORMAT REPLACE

CLIPBOARD MICROSOFT OFFICE HELP SELECTING TEXT
CORRECTION SIGNS MOVE TEXT SYNONYMS AND THESAURUS
Cut NAVIGATION PANE TYPING REPLACES SELECTION
DRAG AND DROP PROOF-READING UNDO

FIND REDO




Icons used in this book

This book contains icons to help guide you in your learning.

The following list shows the icon and its meaning.

3@ Learning Outcomes

Learning Outcomes are displayed on the section page and describe what you will learn in that
section.

EXERCISE 1

These are the exercises that you are required to do. Often there“will be an introduction
sentence to tell you what you will be doing in that exercise.

%& These are notes for your information.

25 Revision

This appears at the end of each sectiopfand,contains theory revision questions relating to
features learnt in that section.

| Practice Assessment

The Practice Assessment at thetend of Section 3 covers consolidation of topics learnt in this
book and provides practice forstudents prior to sitting the actual Unit Standard Assessment.



Save Options

When a document is saved you will be requested to select the location, ie Computer then click
on the Browse button and select the folder required. You can eliminate this procedure by
selecting the location and saving directly to the Save dialog box and therefore bypass Backstage
view.

For the purposes of this book we have used the Documents folder within This PC as the default
folder. This folder is shown below which is the shortcut for the actual path name of
C:\Users\User Name\Documents. This means that files you open and save will be on your hard
drive.

Use the following instructions to specify the Documents folderias the default file location:

. FILE . i
1 Click on the - tab then click on .

Save

2 Clickon : at the left.

3 Ensure that the Documents folder is displayed as the Default local file location as shown
below.

Don't show the Backstage when opening(or saving files
[] Show additional places for saving, evenyif Sigi-in may be required.

[] Saveto Computer by default
Default local file location: E:\USEFSECHEI'}IHDDCLIFHEHH\ Browse...

4  Also ensure that Don’t showithe Backstage when opening or saving files option displays a
tick.

5 Remove the tickdrom the next option Show additional places for saving, even if sign-in
may be required.

6 Click on OK.

% If you wish to open and save files to OneDrive (ie the cloud) use instructions on the next page.

If you have Windows 8, or have updated to Windows 8.1 from Windows 8, SkyDrive may be
displayed instead of OneDrive but is essentially the same.

Vi



OneDrive

OneDrive is a cloud storage application from Microsoft. It is one of the major online file storage
options competing with Dropbox and Google Drive.

Because files are stored “in the cloud” (in addition to your hard drive) it means that you can
access those files from anywhere in the world because you will always have access to the
OneDrive application and your files. You do however need an Internet connection for the files
to be updated from your hard drive to OneDrive.

Saving to OneDrive

OneDrive is automatically set up when Microsoft Qffice2013 (ie Office 365) is installed on your
computer. A OneDrive folder will be displayed on‘thedNavigation Pane in Windows Explorer as
below.
4 fad Onelrive
5 | Documents
NEatorites
Pictures

A Public
7| Shared favorites

Files can be saved manually byielicking on the Save button H on the Quick Access Toolbar,

specifying a name for your filethen ¢licking on the % Onelrive jcon (you may wish to double
click on Documents and saveteo,that folder).

OneDrive as the Défault File Location

Use the followingiifistructions if you wish to specify OneDrive as your default file location.

FILE :
1 Click on the - tab then click on .

Save

2 Click on at the left.

3 Ensure that the C:\Users\User Name\OneDrive\Documents folder is displayed as the
Default local file location as shown on the next page. (You may need to retype the
location)

4 Also ensure that Don’t show the Backstage when opening or saving files option displays a
tick.

vii



5 Remove the tick from the next option Show additional places for saving, even if sign-in
may be required.

Don't show the Backstage when opening or saving files
[[] Show additional places for saving, even if sign-in may be required.

[[] Saveto Computer by default

Default local file location: ChUsers\Cheryl\Onelrive\Docurments Browse...
6 Click on OK.
OneDrive Website

You can log in to the OneDrive website using your web browser with your login name and
password.

The website is www.OneDrive.live.com.

You can upload photos and use files and sharefiles.

Creat
New files can be created through OneDrjyelby clicking on and selecting

the program you wish to use, eg Excel‘(web applications in OneDrive are slightly
cut-down versions of Office 2013 programs).

Folder

Word document

Excel workbook
PowerPoint presentation
OneNote notebook
Excel survey

Plain text document

Sharing Files

From within Excel 2013 you can save files to OneDrive (usually to the Documents folder) and

. . FILE .
then share those files. You can then click on the - tab, on and invite people to
share files in OneDrive.

Alternatively, you can right click on a file in the OneDrive website (see above) and select
Sharing.

Use Google in your web browser to search for additional information on OneDrive.

viii



Exercise Files used in this book

(Instructions are included on the following page for downloading retrievable files
from our web site at www.cherylprice.co.nz)

Names of files

Cavanagh Industries

PC Sales — PivotChart 2

Home Ideas (Categories) 2

PC Sales — PivotChart

Home Ideas (Categories)

PC Sales 2

Home Ideas

~

PC Sales

Mykas — Adelaide

PivotChart 2

Mykas — Brisbane

PivotTables

Mykas — Melbourne

Mykas — Sydney

Organic Foods Co 2

Organic Foods Co 3

rtsyGalore Orders

Q

<
Q
&
¢




Downloading Exercise Files

The exercise files listed on the previous page can be downloaded from the Cheryl Price web
site using the instructions below.

For the purposes of this book we have specified Exercise files to be downloaded to the
Documents folder within This PC which is the shortcut for the actual pathname of
C:\Users\User Name\Documents. This is where files will be opened from and saved to.

1 In the address bar of Internet Explorer, type: www.cherylprice.co.nz

2 Press Enter on the keyboard to display the Cheryl Price website.

3 Click in the Product Search box and type the number of Q US 27642

this unit standard, as shown at the right.

4 Click on :&

5 Clickon US 27642 ((

6 Under the Exercise Files heading click on tQ erlined blue hyperlink, ie
Book Exercise Files — V1 Excel 2013 F ad

The File Download dialog box will dQﬁ

then
b Change file name to US27 Excel 2013 Book Exercise Files.

7 a Clickon * Saveas

c Click on the Document shown below.

& -
P

The Documents folder under This PC is the shortcut for
C:\Users\User Name\Documents

Save

d Clickon

8 a Click on Open folder

b Right click on the zipped exercise file and select Extract All. Click on Extract.
A folder will be created containing the exercise files.

¢ Delete the Compressed (zipped) Folder.




NZQA Outcomes and Evidence Requirements

Unit Standard 27642 (Version 1)

Title Use a pivot table to display data

Level 4 Credits 5

Purpose People credited with this unit standard are able to: create and edit a
pivot table; and create a pivot table report.

Classification Business Administration > Business Information Management

Available grade Achieved

Explanatory notes

1 Definitions
A pivot table summarises data to displaydatain different views.
Software help function includes all @nline or offline proprietary support and tutorials.

2 Assessment against this unit standardimust be based on an existing spreadsheet that
may be provided by the assessomor created by the candidate.

3 Any commonly used proprietary or open-source spreadsheet software may used for
assessment provided it in¢ludes the features, or their equivalents, specified in the range
statements of evidence requirements 1.1 and 1.2.

Outcomes and evidence requirements

Outcome 1

Create and edit a pivot table.

Evidence requirements

11

Pivot table is created in accordance with computer textbooks and/or the software
help function.

Range includes but is not limited to — selecting the data range, define the

category field list, adding and removing fields, adding row labels,
adding column labels, adding data labels.

xi



1.2

1.3

1.4

Outcome 2

Pivot table is edited in accordance with computer textbooks and/or the software
help function.

Range includes but is not limited to — applying styles, formatting value
fields, rearranging table, determining lay-out options, collapsing
and expanding items, sorting fields, adding second value fields,
removing fields.

Pivot table items are grouped in accordance with computer textbooks and/or the
software help function.

Report filter is added in accordance with computer textbooks and/or the software
help function.

Create a pivot table report.

Evidence requirements

2.1 Pivot table report is created, including a pivot.chant, in accordance with computer
textbooks and/or the software help function.
Planned review date 31 December 2016

Status information and last date for assessmentfor superseded versions

Process Version Date Last Date for Assessment
Registration 1 17 November 2011 N/A
Consent and Moderation Requirements (CMR) reference 0113

This CMR can be accessed athttp://www.nzga.govt.nz/framework/search/index.do.

Xii




Section

1 PivotTables

3@ Learning Outcomes

At the end of this section you should be ableo -

Summarise data with PivotTables
Understand the Pivot Cache

Group and Ungroup data infa PivotTable
Change the values calculated in a PivotTable
Use a PivotTable fordata consolidation

Choose and appiya style to a PivotTable

o O 0O 0 o o od

Change the PivetTable Layout

% In this section you will come across the following words highlighted in bold. This
indicates that the word is included in the Glossary at the end of the book together

with a description of that word.

CLASSIC PIVOTTABLE LAYOUT PIVOTTABLE AREA

COLUMN PIVOTTABLE FIELDS LIST

EXCEL LisT PIVOTTABLE REPORT

GROUP DATA PIVOTTABLE STYLES GALLERY
NORMAL LAYOUT PivOTTABLE TOOLS CONTEXTUAL TAB
OUTLINE REFRESHING

PivoT CACHE REPORT LAYOUTS

PIVOTTABLE Row

SHORTCUT MENU
SOURCE DATA

STYLES

SUBTOTALS

VALUE FIELD SETTINGS
VALUES FIELD

© Cherylprice.co.nz Limited

SECTION 1

1




PivotTables

rotated
turned
around

A PIvoTTABLE is an interactive worksheet table that provides a method of summarising and
grouping large amounts of data from an ExceL List. Data can be formatted, and summarised
using various calculations. A PivotTable is also referred to as a PIVOTTABLE REPORT.

area to allow different views of the source data to be displayed. The fields from the list are
placed around the PivotTable skeleton to define how the summarised information is shown
and calculated.

When source data changes, the PivotTable can be updated.

Excel List

For the best results when creating a PivotTable your Excel list sh@uld have the following
characteristics.

e  The first row of the list contains the headers that identify thefdata in each column. The
list does not have to start in row 1 of your worksheet or imeolumn A.

e  Each coLumn (field) contains unique data.
e  Each row (record) contains one set of data for a singlgjitem.
e  There should be no blank rows or columns in theglist:

The PC Sales workbook (which you will use in the firstiexercise), is a good example of such a
list.

A B C y &-. W= F €
1 |Pmduc:t _|"|"ear Month  Sales /' Units Salesperson Region
2 |Hardware 2011 Dec 7536 5863 Green Brisbane
3 | Software 2010 Sep gmp 2956 1242 Hindley Sydney
4 |Software 2011 Octgy —l* 8165 983 Hindley Melbourne
5 |Hardware 2010 Jan Sy, 4448 3833 Hindley Brisbane
6 Hardware 2010 Seprig, 75 3216 Hindley Perth
7 |Software 2010 Feb, J 4923 8160 Green Melbourne
8 |Hardware 2010 Bec._ 0 2733 2790 Green Sydney
9 Software EU@EW 450 9265 Green Ferth
10 |Software 200 Juol a7 3868 Hindley Brisbane
11 |Hardware _Zﬂ_ﬂrl.ﬂar 8751 1773 Hindley Sydney
12 |Hardware @ 20000Mar 2741 6290 Green Brisbane
13 |Software 200 Dec 7047 9888 Evans Sydney
14 |Software 2011 Oct 13 39 Green Brisbane
15 |Hardware 2011 Jun b5T5 9970 Green Perth
16 |Hardware 2011 Jul 7612 3656 Evans Melbourne
17 |Hardware 2011 Aug 4873 2730 Hindley Brisbane
18 |Hardware 2010 Feb 8076 3670 Green Melbourne
19 |Hardware 2011 Oct 3338 1695 Green Sydney
20 |Hardware 2010 Jan 6544 9550 Green Sydney
21 | Software 2010 Oct 6955 8722 Hindley Perth
22 | Software 2010 Feb 4138 4661 Green Perth
23 | Software 2011 Aug 8447 8056 Hindley Perth

2 SECTION1 © Cherylprice.co.nz Limited



summarise
= to
condense
or reduce

Why Create a PivotTable?

SusToTALS feature. For example, in the PC Sales workbook you could display Sales subtotals for
each Region.

You would first have to sort the data by Region, then apply the Subtotal feature (Data Tab,
Outline Group).

1lz]= A B C D E F G H
1 IPr{:-duct .|"|"ear Month Sales Units Salesperson Region
2 |Hardware 2011 Dec 7686 5563 Green Brisbane
3 |Hardware 2010 Jan 4448 3833 Hindley Brisbane
4 |Software 2011 Jul a7 3868 Hindley Brisbane
5 |Hardware 2010 Mar 2741 6290 Green Brisbane
6 | Software 2011 Oct N 39 Green@y(’  Brisbane
T |Hardware 2011 Aug 4873 2730 Hindley™ “yBrisbane
g | Software 2011 Jan 5594 9025 Hindley<%y,. Brisbane
9 |Software 2010 Sep 663 3448 Greemy, Brisbane
10 |Hardware 2010 Jan 6081 9185 Grgen Brisbane
11 |Software 2011 Jan 9662 9441 Green/ Brisbane
12 |Hardware 2011 Feb 5010 3030 indley Brisbane
13 |Hardware 2010 Feb 3571 54¥8 Hindley Brisbane
14 |Software 2010 Oct 2423 2398 NHindley Brisbane
15 |Software 2010 Maov 8670 o 285 Hindley Brisbane
16 |Hardware 2011 Sep 66 Bf40 Green Brisbane

=] 17 69486 L6442 Brisbane Total
18 |Software 2011 Oct 81&‘@— » 383 Hindley Melbourne
19 | Software 2010 Feb 4923t 8160 Green Melbourne
20 |Hardware 2011 Jul 512 3656 Evans Melbourne
21 |Hardware 2010 Feb (8076 3670 Green Melbourne
22 |Hardware 2010 Sep A4 4873 Hindley Melbourne
23 |Software 2010 Oct 1 347 5881 Green Melbourne
24 |Software 2011 May N 9566 7406 Green Melbourne
25 |Software 2010 Oct 2516 9191 Hindley Melbourne
26 |Hardware 2011 Jul 9082 8966 Green Melbourne

Using the automatically applied OUTLINE you could show or hide data levels, but if you required
subtotals based on other fields you'would have to re-sort the list and apply the Subtotal feature
again.

When you summarise youridata“in a PivotTable, you can display different views of the data
without having to recreate the table each time.

Creating a PiyotTable

The Pivot Cache

When a PivotTable is created, it is not directly linked to the data source. This is because when
you begin the process, the first step that Excel takes is to create a duplicate copy of the data
source and store it in a Pivot Cache. This occurs every time you create a PivotTable from a data
source, which automatically increases the file size and the amount of memory being used.

When you make changes to the data source, this is not automatically reflected in the
PivotTable. This is easily managed by REFRESHING the data.

Efficient use of the PIvoT cAcHE and how to refresh data is covered later in this section.

© Cherylprice.co.nz Limited SECTION1 3



EXERCISE 1

4

Open the workbook called PC Sales

Ensure the Database worksheet is displayed.

INSERT 21 then on PietTable

With the cursor anywhere within the list, click on the
The Create PivotTable dialog box is displayed.

Ensure the Select a table or range and New Worksheet options are selected and that the
Table/Range is as shown below.

Create PivotTable ?
Choose the data that you want to analyze

@ Select a table or range
Table/Range: | Database!SAS1:5G55%
O Use an external data source

Choose Cannection

Connection name: Q
Choose where you want the PivotTable report to b&
(®) New Worksheet
Dgxisting Worksheet
Laocation: Q [F:5
Choose whether you want to analyze mu(e ta

|:| Add this data to the Data Model

Click on OK.

A new sheet is inserted to the left of the Database worksheet (Sheetl); a PIVOTTABLE AREA
is displayed, together with the P LE FIELDS LIsT Task Pane (at the right) and the
PivotTable Tools, Analyze and i s as shown below.

&
¢

SECTION 1 © Cherylprice.co.nz Limited



6

There are two ways in which a PivotTable can be used and manipulated:

o NORMAL LAYOUT as shown on the previous page.

e CLAsSIC PIvOTTABLE LAYOUT which displays a grid — fields displayed in the PivotTable Fields list

can be dragged onto the grid (see illustration on next page).

Change the PivotTable layout view to Classic PivotTable Layout as follows:

a  Onthe PivotTable Tools, Analyze tab, click on [ Options - )
b Inthe PivotTable Options dialog box click on the Display tab.

¢ Ensure atick is displayed in this option:
Eqassic PivotTable layout (enables dragging of fields in the grid)

d Click on OK.

% This applies the Classic PivotTable layout to the current PivotTable only.

The PivotTable area is displayed showing all the field areas in the PivotTable.

The fields in the database are listed in the PivotTable Figlds list' Task Pane at the right of the

screen.

PivotTable Location Notes

When creating a PivotTable you specify where®iou want it located in the Create PivotTable
dialog box. The usual recommendation (which,is the default option in the Create PivotTable

dialog box) is that it is placed on a new worksheet.

If you decide later that you want to move‘@a‘PivotTable to a different location, follow these

steps:
1  Select a cell in the PivotTable:
2 Inthe Actions group on thefPiotTable Tools, Analyze tab, click on [ Move PivotTable
The Move PivotTable dialeg box.is displayed.
Move PivotTable ?
@hdese Wwhere you want the PivotTable report to be placed
(2 Mew Warksheet
| | (#) Existing Worksheet

Location: | Sheeti!A3 i

3 Specify where you want the PivotTable moved to, then click on OK.

© Cherylprice.co.nz Limited
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PivotTable Organisation

You specify the fields you want to include in the PivotTable by either dragging them to the
appropriate area in the lower half of the Task Pane

OR
To the PivotTable area itself (if you are displaying the Classic PivotTable layout).

Drag fields between areas below:

T FILTERS Il COLUMMS

=

B c | o , F G

1 " Drop Report Fit Pricldt Here |
2 -
3 _| Dro n Fields Here
4 O
51 O
6| T
7
— A
g Q
9 | = .
o = |Droxalue Fields Here
I D
12 | E
13 | w
14 I
15| @
D

a PivotTable are described on the next page. These are shown in
in the lower half of the PivotTable Fields list.

The four areas that
the PivotTable Area and

% The names used in the PivotTable Area are slightly different to those used in the PivotTable.

6 SECTION 1 © Cherylprice.co.nz Limited



filtered

sorted,
extracted

Report Filter/Filters

In effect, individual PivotTables are created for each possible value in the Report Filter Field as
well as for all the values.

For example, in PC Sales the Report Filter Field could be Year, which would produce three pivot
tables:

e one for 2010
e onefor 2011

e one for both years combined

Only one of these PivotTables is displayed at any given time, depending on which Report Filter
Field value is selected.

Similarly, if Region was specified as the Report Filter Field, the“data for all regions or for
individual regions could be displayed.

Column Fields/Columns

Column Fields are used to create the horizontal axis ofithe PivotTable.

If more than one field is placed in the Column Labels area’you should place them in descending
order of importance.

For example, you would place Month below Yearin the Column Labels box in the PivotTable
Fields list so that sub-totals for each month within each year could be created.

Row Fields/Rows

Row Fields are used to create the,Vertical Axis of the PivotTable.

You can place more than one fieldiin the Row Labels area using the same method as described
above for placing multiple Coldmn Fields.

Value Fields/Values

Field(s) placed in the Valdes area contain the data to be summarised using any of the available
functions such as Sum, Average, etc.

A PivotTable must have at least one VALUES FIELD.

Totals and Subtotals

When a PivotTable is created, subtotals and grand totals are automatically generated. These
can be deleted or hidden if required.

Because these totals are produced based on the data in the list, you should ensure that the list
does not also contain subtotals.

© Cherylprice.co.nz Limited SECTION1 7



EXERCISE 2

The PivotTable will initially be set up to display the sales for all products for each salesperson
within each region.

1 Dragthe Product field to the Filters area as shown below.

PivotTable Fields X

Choose fields to add to report:

E"ag thef' Id

< roduct fiel

[ Produg 2] from here

L[] Year down to the

["] Month Filters area

[ sales N
[] Units

[ Salesperson

oy

Drag fields between apfas below: Y FILTERS The Product field is now
displayed in the Filters area
Il COLUMNS P'rcndur:ts

= ROWS  VALUES Q
o The Product field is also

displayed in the PivotTable grid
as shown below.
[ ] Defer Layout Update UPDATE
\ B c | o | E | F | & |
1

T FILTERS

1
Product (All)| - | |

Drop Column Fields Here

Ilﬂm‘dmm#lﬂ

Drop Value Fields Here

aloH splel4 moy doug

2 Dragthe Salesperson field to the Rows area.
3  Drag the Region field to the Columns area.

4  Drag the Sales field to the Values area. This will be labelled Sum of Sales — Sum is the
default function.

The fields are also displayed in the actual PivotTable area on your worksheet.
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If you are using the Classic PivotTable layout you can also drag the fields onto the
appropriate section of the PivotTable area.

If you place a field in the wrong area, simply drag it to the correct area.

The PivotTable is displayed as shown below.

5 Rename the worksheet PivotTable 1.
6  Click on the Product (All) down arrow in cell

&
&
$
S

Search 2
o

The options shown below will be display

SD Select Multiple [tems
'b

Cancel
7  Select Hard iew only hardware sales. Click on OK.

A B | C [ B [ E [ F [
1 Product Hardware -T |
2
3 |Sum of Sales |Region |~
4 | Salesperson ~ |Brisbane  Melbourne Perth Sydney Grand Total
5 |Evans 7612 6028 8516 22156
6 |Green 16674 28134 22077 12615 79400
7 Hindley 17902 2420 10858 22746 53926
8 Grand Total 34476 38166 38963 43877 1655482

The down arrow button now shows as ﬂ, indicating that the PivotTable is filtered.

8 Click on the Product ﬂ , select Software and click on OK.
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PivotTable Tools Contextual Tab

When you select any cell in a PivotTable, the PIvOoTTABLE TOOLS CONTEXTUAL TAB is displayed on
the ribbon. It includes two tabs — Analyze and Design.

The Analyze Tab

The Analyze tab includes a wide range of options that allow you to modify calculations, update
the table data, show or hide elements of the PivotTable, etc.

The Design Tab
The Design tab allows you to adjust the layout of the table, apply preset styles to the table, etc.

H O W& @ Aa- PC Sales - Excel PIVOTTABLE TOOLS
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ER ANALYZE DESIGN

~| Row Headers Banded Rows

Subtotals Grand Report Blank
@ Totals~ ' Layout~ Rows~

Layout PivotTable Style Options PivotTable Styles

+| Column Headers Banded Columns

The PivotTable Fields list is also displayed whenevemyouractive cell is within the PivotTable.

EXERCISE 3

>  Click outside the PivotTable. The PivotTableTools contextual tab and the PivotTable Fields
list are hidden.

Displaying Report Filter Pages

Individual PivotTables for each uniqué value in the Filters field can be created on separate
sheets (pages) in the workbook.

EXERCISE 4

1  Select a cell in the table, click on the Product down arrow L™ in cell B1 and select (All).
2 Click on OK.

3 On the PivotTable Tools, Analyze tab, click on the Options button down arrow in the
PivotTable group.

|__I|:| Options =
PivotTable

4 Select ||=|:| Show Report Filter Pages...
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5 Click on OK.

Two new worksheets will be inserted into the workbook, o

Show Report Filter Pages

Show all report filter pages of:

n

Hardware Software

6 Review the Hardware and Software worksheets, and th

shows All).

Changing the Layout

EXERCISE 5

The lower half of the PivotTable Fields li
from one box to another.

» I

e ach Product category.
PivotTable 1 | a |

&

&

In the following exercise the PivotTable layout will Qged to display the product sales for
each salesperson with a subtotal for each salespefson

O

rn to PivotTable 1 (which

used to reorganise the fields by dragging them

1  Drag the Product field which is Wilters box so it is under the Salesperson field in the
i

Rows section of the PivotT\

ist as shown below.

= ROWS
Salesperson ¥
& Product &

The table will be di ed as follows.
B , C , D , E F G

1 | Drop Report Filter Fields Here

2

3 | Sum of Sales l Region |~

4 |Salesperson |~ Product| ~ |Brisbane  Melbourne Perth Sydney Grand Total
5 | =Evans Hardware 7612 6028 8516 22156
6 | Software 1361 9713 11074
7 |Evans Total 8973 6028 18229 33230
8 | =Green Hardware 16574 28134 22077 12615 79400
9 | Software 17521 21836 10308 13756 63421
10 |Green Total 34095 49970 32385 26371 142821
11 | =@ Hindley Hardware 17902 2420 10858 22746 53926
12 Software 17439 13787 16431 9386 56593
13 |Hindley Total 3530 16207 26289 32632 110519
14 |Grand Total 69486 75150 64702 77232 286570

© Cherylprice.co.nz Limited
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2 Rearrange the fields as follows.

FILTERS COLUMMNS
Salesperson  *
Product 5

ROWS £ WALUES
Region i Sum of Sales =

The PivotTable is now displayed as shown below.

A B
1 |Salesperson  (All) |~
2 Product (Al |~
3
4 |5um of Salesl
5 Region - |Total
6 |Brisbane 69486
7 Melbourne 751504
8 |Perth 64702]
9 | Sydney Ti232
10 Grand Total _| 286570}

-

3  Click on the Salesperson (All) down arrow ., seléct Evans and click on OK.

-

4  Click on the Product (All) down arrow |7, seleet,Software, and click on OK.

B
1 Sale Evans |-T
2 |Pro Software -T
3

4 | Sum, of Salesl
5 of - |Total
Snelbeume 1361

Syidney 9713
8 rand Total 11074

5 Redisplay the data for all Salespersons and Products.
6 If necessary, click in thetPivotTable to show the PivotTable Fields list.

Rearrange the PivotTablépto display as shown below. (See if you can do this on your own
—then look at the nextpage to see how the fields are positioned in each field box.)

A o C D E F G

1

2 [Salesperson [(Al) |~ |
3

4 | Sum of Sales Region -

5 |Product ~|Year - |Brisbane Melbourne Perth Sydney Grand Total
6 | = Hardware 2014 16841 17525 16783 32947 84096
7 2015 17635 20641 22180 10930 71386
8 Hardware Total 34476 38166 38963 43877 155482
9 | = Software 2014 11766 14786 11543 19144 57239
10 2015 23244 22198 14196 14211 73849
11 | Software Total 35010 36984 25739 33355 131088
12 | Grand Total 69486 75150 64702 77232 286570

1%
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